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If you are reading this article you are either a practitioner of Computer Aided
Engineering or you are stuck on a desert island and this is the only thing you have
to read.  Let's assume the former.  If you boil down why  your company does
CAE, you should come to one or both of the following reasons: to reduce your
costs for physical prototyping and/or to increase the number of design iterations
through the use of virtual prototypes.   Study after study, even ones not paid for
by CAE software companies, show that leading companies use more CAE,
earlier in the design cycle.  Figure 1 shows the results of one such study from
the Aberdeen Group.

You may be new to CAE, or a 20+ year user.  Either way, how does your company maximize the return from their investment in you,
your co-workers, the software and the hardware? And do not forget that annual maintenance fee you pay.  PADT's internal experience
and lessons learned from our customers, leads us to recommend that the best way to get the most out of that investment

ANSYS supports several of the common techniques used to analyze cracks.  In a
typical first analysis, an engineer assumes a flaw shape and size and then uses the
stress results from an FEA model as input into NASGRO.     If a more detailed
simulation is required, an FEA model  with a crack included can be created.

There are a few guidelines for using ANSYS to model  cracks, the guidelines will
be demonstrated through an example of a steel turbine wheel, shown in Figure 1,
which has been assumed to have a crack introduced during the balancing process.
A link to the geometry model (v12 UP20090415) and APDL command files are
provided at the end of this article in order to allow the user to reproduce this
analysis step by step.
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Modeling
Cracks with

ANSYSYou do an article on crack modeling, and
you have to go with the classic “fat guys

on a stool” pictures.  No Choice.

Maximizing the ROI on
your CAE Investment

(Cont. on pg. 7)

Instead of using cheesy graphics with money bags, scales,
and overly attractive “employees” in meetings, we decided to
dress up this article with pictures from around Arizona.  This is
from the top of Four Peaks, the mountains east of Phoenix.

(Cont. on pg. 2)

Issue 74, the Last “Magazine” Style Issue of The Focus
It is hard to believe that the next issue of The  Focus will be the 75th!  We hope you have enjoyed reading it as much as we have
enjoyed making it.  As we prepared this issue we came to the realization that this format has served its purpose and that various
Internet based publishing tools have matured to the point where it is time to make a change.  We are leaning towards more of a
blog approach where we put out single articles once every other week or so, instead of the big issue.

So look for a lot of changes to how we publish and distribute The Focus in the coming months.  And thank you again for everyone's
continued support of this publication!

http://www.padtinc.com/epubs/focus
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is to focus on four key aspects of CAE: goals, people, tools, and process.  In this
article we will talk about each and how to make each aspect work for you.

Goals
If you have every read an article or attended a seminar hosted by PADT on being
more efficient/productive you will always hear us start off with goals.  We feel
that a lack of clear goals is a huge productivity killer.  We find again and again
that companies or teams that successfully use CAE have clear goals for their
entire CAE effort. Goals  that they develop, document, and modify as needed.
As an example, PADT's CAE goal is: To answer questions raised in product
development in the most cost effective manner with the proper level of accuracy
and detail.  It may not roll of the tongue but it gets the job done and helps keep
us from going off track.

Just as every organization should have goals for their total CAE effort, they
should also get into the habit of forming goals for each CAE task they undertake.
This does not need to be formal but should at least address what you want from
the calculations you are doing and how accurate they need to be.  You should
write them out, kind of like a customer specification and they should never be longer than one sentence.    Once they are written down
they can help the engineers involved in the middle of the project, and will help new engineers understand why they are doing the CAE
tasks that they have been assigned. Example task goals could be:

· Determine cooling hole size and distribution to obtain required wafer cool down in between 45 and 60 seconds
· Report LCF and HCF life based upon customer supplied loading specification
· Modify antenna design to minimize material costs and meet signal strength requirements in ES 123.31
· Determine min, max and average percent enobarnotopital to provide a between 95% and 99% probanotinaium yield

If the tasks are part of a major effort, it might not be a bad idea to review them weekly.  Making goal setting and review part of your
CAE culture can have a huge impact — keeping projects on focus, under budget and most importantly, delivering the information that
the design team actually wants.

People
It is hard to understate the importance of people in making a CAE effort a
success, a failure, or just so-so.  From key super users to engineers who are in
over their heads, people are the most important aspect of getting the most out of
your CAE investment.  They are also the hardest to control.

Dig deep into companies that are true CAE superstars — time and time again
you will find one or more key users. Some call them gurus, some are called
power users, and still others are simply referred to as simulation gods.  We prefer
the less charged term "key users."  They prove that one person can make a
difference by pushing technology and applying it properly. They  also help
management make smart tool decisions. Most importantly they mentor, train,
and serve as examples for the other users in the organization. Sometimes these
key users are simply users, sometimes they are managers or members of methods
teams.  Regardless of where they come from they share some common charac-
teristics:

· Balance between theory and practical
· Creative, willing to experiment and try different ways
· Fast thinkers
· Obsessed with efficiency
· Learn things quickly with minimal input
· Good at programming/scripting
· Involved in real world applications
· Strong computer skills

If you are a key user, embrace it and work to help make your organization better.  If you are a manager or user who sees the need, work
to grow key users by identifying them and encouraging them to take on a strong role.  Then focus on keeping them engaged in key
activities and decisions.  Doing so will be one of the best investments any organization can make.

(ROI, Cont...)

(Cont. on pg. 3)

A picture from Sedona looking up to the Red Rocks.  Notice
the reflection in the pool.  This is a required shot for all visi-

tors to Sedona.

Oak Creek Canyon is one of the green oases that we go nuts
for here.  People back east have this sort of thing in their

backyard but for us it is a big deal.
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On the other end of the spectrum, and just as powerful, is the anti-particle to the
key user — the bad user.  We would like to live in a world where "everyone gets a
trophy" but in the real world some people should not be involved in computer aided
engineering.  A few are bad users by nature.  They are generally too practical or too
theoretical. They also do not remember steps in a process or have a lack of concern
about speed.  Lastly they are often not computer experts and get stuck a lot,
struggling with solving problems independently.  The key thing is to find people
like this and take them out of CAE.  There are plenty of other engineering tasks out
there that may be a better fit for this type of person.

However, the more common bad user is not bad by nature, they are bad by nurture.
A perfectly capable engineer can do a rotten job at CAE because their company did
not use them properly.  Typical problems are not enough training, spreading them
too thin or not giving them the compute horsepower they need. It is also common
to not allow them to do CAE often enough to be good at it.  Even if those problems
do not exist you can get bad results by giving people unreasonable schedules,
unrealistic expectations or punishing them for delivering bad news.  The good thing about someone who is a bad user because of external
influence is that you can flip them into being a good user by removing the negative parts of their environment.

In talking about key users and bad users, we have left out the largest group of users - the mainstream day to day engineers who do the
bulk of the CAE work.  Because they are the largest group, it is important to remain focused on them.  Make sure your organization
maximizes your considerable investment in them by making some key commitments like giving them the proper hardware and software
that they need. Then provide them the time to learn those tools, clear goals, and encouraging them to work together and share their
knowledge and skill.

In short, focus on your people and they will deliver for you.  Encourage the truly capable and nurture the average users.  And do not be
afraid to move those who are not a good match for CAE out of the area.

Tools
When people think about CAE, most of the time they focus on tools.  Hardware and software are cool, always getting better and fun to
evaluate.  But, they also cost a bit so companies need to be smart about how they choose and use their CAE tools.

It is obvious that hardware tools (computers) are an essential part of CAE.  Even though this is obvious, many companies often make
horrible mistakes in choosing and setting up their hardware. Users end up with machines that struggle to solve their problems.  A major
cause of this is IT departments that have no understanding of CAE.  It is up to your CAE team to educate them to recognize that your
needs are different.  And eventually convince them to proactively help you.

When purchasing hardware for running numerical simulations it is important to make the right decisions.  The most important is to make
sure you have more speed, memory and disk storage than you think you will need.  This is because no matter how much you think you
need, you will need more. Saving a few hundred, or even thousand dollars on a computer can end up costing your company tens if not
hundreds of thousands in schedule delays or reduced accuracy.  Along those lines, it is also important to not get too hung

The Editor for ANSYS APDL Users
PeDAL is a Windows text editor for ANSYS APDL scripts. It integrates with the ANSYS help
system to provide instantaneous help on any one of the 1,000s of ANSYS commands. PeDAL
was written by Matt Sutton, an Engineer at PADT, to make his own job easier. Matt has years
of experience writing APDL scripts and has long wished for a tool that would provide help for
a given command right at his fingertips. Pedal can be purchased for $49 by pressing on the
Buy Pedal button below.

Key Features
� Side-by-side editor and help viewer layout.
� Instant help on any documented APDL command by pressing F1.
� Full syntax highlighting for ANSYS v12 Mechanical APDL.
� Auto-complete drop downs for APDL Commands.
� APDL Command argument hints while typing commands.
� Mouse hover command descriptions.
� Much More...

Download your 30 day free trial or learn more details at:
www.padtinc.com/pedal

(ROI, Cont...)

Up in Northern Arizona on the Navajo Nation there are
these incredible slot canyons.  Cut by wind and water,

the way the light shines down is incredible.

(Cont. on pg. 4)

http://www.padtinc.com/pedal
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The Focus is a periodic publication of Phoenix Analysis & Design Technologies (PADT).  Its goal is to educate and entertain the worldwide
ANSYS user community.  More information on this publication can be found at: http://www.padtinc.com/epubs/focus/about

(ROI, Cont...)

(Cont. on pg. 5)

up just on speed.  Often times capacity is
more important than raw compute speed.
Look at the overall time it takes to run jobs
including file transfers, I/O to disk, being
able to run in core and actual CPU speed.

In larger organizations PADT recommends
a tiered approach to hardware: good large
desktops, departmental servers for medium
sized jobs and a corporate cluster if you need
to solve lots of problems or big ones.  This
gives your team greater flexibility and pro-
vides the right machine for different jobs.
Another suggestion is to work closely with
your IT department to make sure they under-
stand that you cannot use a "standard build."
We see many of our customers hamstrung by the fact that they can only get a machine that is a PLM or CAD standard box and it does
not have the RAM or disk capacity needed for their analysis.

Software for CAE is the one area the usually gets a lot of focus, and it deserves it.  But not just for the CAE software itself.  It is important
to also focus on utility software that leverages your CAE software and makes your users more productive.  As an example, we
recommend that all CAE users have access to a CAD tool or some sort of geometry translate/repair tool.  Often times the tool imbedded
in your CAE software is not powerful enough and waiting on someone from the CAD group can kill a schedule.

Other utility software that every user should have include:

· MS Office - do not waste time trying to get some other office tool to work.  Just suck it up, pay Microsoft their blood money,
and be productive

· Text Editor - Invest in a good text editor for looking at output files, writing scripts, and viewing text information.  These don't
cost much and getting a nice one can save hours every month.

· Image Editor - Making pretty pictures is a large part of a CAE user's time.  Not having a good image tool can waste hours in
non-value added fiddling trying to get pictures just right.  Get PaintShop Pro, Photoshop, Gimp or some other tool and learn how
to use it.

· Virtual Meeting Tool - Share your data easily and quickly with your customers, support provider and co-workers with a tool like
WebEx, iLinc, or go2Meeting

· Linux Shell on Windows, Virtual Windows on Linux - If you have a multi-OS environment, invest in emulators so you are not
always working around the system.

Process
Last but certainly not least is process.  One of the problems with CAE is that there are so many different ways to solve a problem, and
they all involve detailed steps so it is easy to lose your way.  Taking the time to establish standard processes can avoid reinventing the
wheel. They keep users on task, allow productivity gains to be captured, and provide a great guide to new or occasional users.  The most
important benefit of having well documented process is the repeatability of the work.

Like a lot of good things, an organization can go way overboard in this area.  Processes need to be flexible and adaptable to real world
circumstances.  Our experience is that if a company has rigid processes, engineers often "go rogue" simply out of spite. A good
compromise is to standardize the steps in the ideal process in detail, and give guidelines for the overall process.  This allows users to
reuse what applies and adapt as needed. That same experience has taught us one more thing about the effective use of processes - they
are most effective in companies where a person who is reasonable but strong willed is given the authority to collect, maintain and enforce
processes.

General Recommendations
These four areas of focus should help any organization that uses CAE be more efficient and get more value from their CAE investment.
Think: GOALS, PEOPLE, TOOLS, PROCESS and try and not focus on the minute details of applying CAE.  Also, try and focus on the
things you can change. Goals are the easiest but if you can make changes to your people, that may deliver the best results.   Try and get
your whole organization, users, project engineers, management, thinking about CAE as a tool instead of as a black box or a magic bullet.

Another recommendation that we have seen generate good results is to build a positive relationship with your IT team.  We have seen
companies that fight with their IT, get nowhere, and end up not having the compute resources they need to be efficient.

You can’t show pictures of Arizona without one of our spectacular sunsets

http://www.padtinc.com/epubs/focus/about
http://www.padtinc.com/epubs/focus/default.asp
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(ROI, Cont...)
And when something goes wrong it takes forever to get back on
track.  Take the time to work with IT, letting them know what you
plan on doing way ahead of time. Also, take the time to understand
what they do.  If you can do these things and build a strong personal
relationship with them and maybe even help them out every once in
a while, you will get greater efficiency and less down time.

A similar recommendation is to get to know your internal and
external technical support providers and build a good relationship
with them. Recognize the fact that providing tech support is a hard
job with little thanks.  If you go out of your way to appreciate what
they do for you, the result will be an extra effort from the support
provider to make you successful.  Lastly, do not cheap out, pay your
maintenance fees.

The last recommendation that PADT usually makes is the hardest to
make happen.  In company after company we see people using the
wrong tools, using tools in the wrong way, and wasting time on
arguing about tools because some of the engineers get "religious"
about their CAE tools.  They need to remember that they are engi-
neers doing calculations to solve problems, not ANSYS or NASTRAN jockeys.  To stretch the analogy even further, when you start
having faith in your tools, it is time for a reality check.  A healthy dose of skepticism is important to making sure you get the most out
of your CAE investment.

Next Steps
The first step in maximizing your ROI in CAE is to first recognize that you need to do things to maximize it.  The next step is to identify
your goals and document them. Work on getting the proper people involved and make sure you have the right tools and your users know
how to use them.  Then identify and document some flexible processes.

Looking at this as a bigger picture, the key aspect turns out to be changing the way your company thinks about CAE.  In every area listed
above it really boils down to not treating simulation as a black box but as a powerful tool that needs to be used properly by the proper
people.  Once you make this change, work on getting your organization to understand the value of CAE and to treat it as a strategic asset.
When you look back on the efforts you have made to improve your use of CAE, the biggest change you should see is that you are now
driving most of your designs efficiently and accurately with simulation.

By Jeff Strain
For many versions, ANSYS users have had the ability to sweep mesh extrudable volumes in both ANSYS "classic" Mechanical APDL
and Workbench Simulation Mechanical.  However, there was one big caveat: there could only be a single source face (the face from

This is a place called Boulder Canyon. It is a fairly typical desert can-
yon with stunning rocks and endless vistas.

(Cont. on pg. 6)

Thin Sweep: Sweeping Away Sweep
Mesh Restrictions

Figure 1: Your Typical Sweep Mesh - Single Face Source, Single Face Target Figure 2 Bwuh?? How'd he do dat?
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which the mesh is swept) and a single target face as
in Figure 1 (the face to which the mesh is swept).

But wait! What if I told you that, in Workbench
Mechanical, you can sweep mesh an extrudable vol-
ume having multiple source and target faces (Figure 2)?

The trick to this, my friends, lies under the Src/Trg Selection options within the
Sweep Method mesh object.

The first thing you want to do is insert a Method object under the Mesh branch
(Figure 3).

Select the geometry to be meshed and set "Method" to "Sweep" in the Details
window (Figure 4).  Now for the magic.  From the "Src/Trg Selection" pull-down
menu, select either "Automatic Thin" or "Manual Thin."  If you select the
"Manual Thin" option, you'll also have to select the source faces.  The
"Automatic Thin" option allows the Workbench mesher to figure it out on its own
(Figure 5).

It's also a good idea to specify the number of element divisions through the
sweep mesh.  My experience has been that, even with the number of divisions
set to "Default," I still get just a single element through the sweep unless I set it
manually, regardless of global element size (Figure 6).

Once you specify these settings and generate the mesh, you end up with a
beautiful sweep mesh as shown previously in Figure 2 (assuming, of course,
you've applied these specifications to an extrudable volume).

Now, you may be asking me telepathically from your desk, what element type
do you get with this "thin sweep" option, at least with a structural analysis?  Are
they SOLID186s?  SOLSH190s?  Writing out an ANSYS input file, bringing it
into Mechanical APDL, and listing the element types give us our answer (Figure
7).

Figure 7 They're SOLID186s: Your Typical Workbench Structural Brick Ele-
ments

For a thermal analysis, thin sweep meshing produces SOLID90s which, again is
consistent with a standard thermal brick mesh.

Interested in learning about other Workbench tricks?  Consider taking our Introduc-
tion to Workbench Mechanical course, prepared by ANSYS users (i.e. your friendly
neighborhood PADT engineers) for ANSYS users.

Figure 5: Thin Option for Source/Target Selection

Figure 6: Setting the Number of Sweep Divisions

Figure 7: They’re SOLID186’s - Your Typical Workbench Structural Brick Elements

(Thin Sweep, Cont...)

Figure 4: Sweep Method Specification

Figure 3 Right-Click Mesh Object > Insert > Method

http://www.padtinc.com/support/training/course.asp?c=103
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Part 1 of this article in the previous issue of The Focus covered the use of KCALC and
the steps used to prepare a mesh for its use.  Recent versions of ANSYS have added
commands to simplify the process.  Refer to Part 1 for details of the model creation.  The
meshing scheme is similar with the exception that we use solid186 and solid187 instead
of solid95 and solid92.

Figure 2 shows the mesh, note that the wedge elements at the crack tip need to have the
midside nodes moved to the 1/4 radius location.  This creates the stress singularity needed
to properly model the stress distribution seen in a crack front.

A baseline model was first run without a crack.  The S1 result from that run is shown in
Figure 3.  Maximum S1 shown is equal to 28.4 ksi.

The model was then run with a 0.020in deep crack.  Maximum S1 shown in Figure 4 is
equal to 79.6 ksi.

 Issue CINT,TYPE,JINT prior to solution for ANSYS to calculate the J-integrals.  If you
issues a CINT,TYPE,SIFS prior to solution, ANSYS will calculate the Stress Intensity
Factors (K1, etc).

CINT,TYPE,JINT
Once the model has been solved, the J-integral can be listed in POST1 using the PRCINT command.  One advantage of using PRCINT
instead of KCALC is that you no longer need to identify the path used.  ANSYS calculates the J-integral for all of the nodes identified
in the CINT,CTNC command.  Partial results of PRCINT are shown in Figure 5.  This example used 6 contours (CINT,NCON,6) so
there are 6 values calculated.  Each contour represents a calculation including that "number of rings of elements".  In other words,
contour number 3 includes 3 rings of elements when integrating the path around the crack.

Figure 1: Fictitious Turbine Wheel Analyzed

Figure 2: Meshed model, red=solid187, purple=solid186, elements at the crack tip have the midside nodes

Figure 3: S1 plot of the model without a crack
Figure 4: S1 plots of the model with a 0.020in crack

(Crack, Cont...)
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J integral values can be used for a variety of analysis purposes.  One of them is calculating KI which can be done like this:

K=(30E6/(1-(0.29*0.29))*ABS(J1))**0.5  ! WHERE E=30E6; NU=0.29
K=3157 for J1=-0.30424

CINT,TYPE,SIFS
Once the model has been solved, the Stress intensity factors can be listed in POST1 using the PRCINT command.  Again, there is no
need to identify the path used.  ANSYS calculates the stress intensity factors for all of the nodes identified in the CINT,CTNC command.
Partial results of PRCINT are shown in Figure 6.

SUMMARY of Part 2
- Crack parameters including KI, KII, KIII are calculated using CINT and PRCINT commands

The APDL and geometry files are available here: ftp://ftp.padtinc.com/public/thefocus/Focus74_CINT_Files.zip

See section 12.3. Numerical Evaluation of Fracture Mechanics Parameters of the Structural Analysis Guide for a thorough discussion
of all the possible crack options.

***** POST1 J-INTEGRAL   RESULT LISTING *****

 CrackID =   1

  Crack Front Node =    1
   Contour Values =  -0.30452     -0.30426     -0.30452     -0.30446
   Contour Values =  -0.30436     -0.30424

  Crack Front Node =   56
   Contour Values =  -0.29170     -0.32318     -0.32376     -0.32400

Figure 5: PRCINT,1 output, results for the first 2 nodes shown.

***** POST1 K1           RESULT LISTING *****

 CrackID =   1

  Crack Front Node =    1
   Contour Values =    3153.1       3105.8       3104.3       3098.7
   Contour Values =    3091.5       3082.2

  Crack Front Node =   56
   Contour Values =    2944.4       3196.6       3192.7       3191.1
   Contour Values =    3190.0       3188.9

Figure 6: PRCINT,1,,K1 output results for the first 2 nodes shown

PADT’s Training Schedule
Month Start End # Title Location
Jul '10 7/8 7/9 103 Introduction to ANSYS Workbench Mechanical Albq, NM

7/12 7/14 101 Introduction to ANSYS (Mechanical APDL), Part I Albq, NM
7/15 7/16 801 ANSYS Customization with APDL Tempe, AZ
7/19 7/20 203 ANSYS Mechanical APDL Dynamics Tempe, AZ
7/22 7/23 102 Introduction to ANSYS (Mechanical APDL), Part II Tempe, AZ
7/26 7/27 502 ANSYS Explicit STR Tempe, AZ
7/28 7/30 152 ANSYS ICEM CFD Tempe, AZ

Aug ‘10 8/3 8/12 113 Introduction to ANSYS Workbench Mechanical (Web Class) Web
8/5 8/58/ 702 ANSYS DesignXplorer Tempe, AZ
8/6 8/6 605 Overview of CFX for the Non-CFD Specialist Tempe, AZ
8/9 8/10 152 ANSYS ICEM CFD Tempe, AZ

ftp://ftp.padtinc.com/public/thefocus/Focus74_CINT_Files.zip
http://www.padtinc.com/support/training/
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By Eric Miller
We have all been there before.  You are poised in front of your

computer, you just want to read in your geometry and throw on a
quick mesh to see what you have and how much effort this will
take.  Next thing you know you are getting errors or red lines are
showing up on your geometry.  You got bad geometry and now
you need to clean it up. You got them Bad Geometry Blues.

There are a lot of options available including: 1) going back to the
original CAD and fixing that, 2) using a repair tool like CADFix,
3) using some intermediate geometry tool that is good at repair
like SpaceClaim or IronCAD, or 4) meshing in ICEM CFD which
is much more forgiving with bad geometry.  All of these work and
may be the way you have dealt with this situation in the past.  But
you should also be aware that ANSYS DesignModeler has an
array of tools purpose build to help you solve this problem.

The first thing to try are the options when you read your geometry
in to DesignModeler.  Figure 1 shows the appropriate details view.  You can have the program simplify
geometry, simplify topology, heal the body or clean the body.  The program can also try and replace any
missing geometry.  By the way, the options available change based upon where your geometry came from
so if you do not see all of them, that is normal. Heal geometry is on by default, as is clean.  Sometimes
you may not want them on.  Play with simplifying as well.  Sometimes modifying these options can clean
everything up.

If the automatic stuff does not work, it is time to look at the
tools available to you in DM.  The first to look at is the “Small
Entity Search.” Just as the name implies, it goes out and
identifies where you have small entities and gives you their
size.  You access the command a little differently in that it is
not something you insert into the tree.  Go to Tools > Analysis
Tools > Small Entity Search. This will bring up the Details
View shown in Figure 2.  Pick one or more bodies you want
checked and set the options, although the defaults are usually
good.  Then, this is the strange part, change the option next to
“Go!” to “Yes” It will do the search and present the results
down below.  Click on any item listed and you will be able to
see it on the screen.  This should help you understand where
you might have problems before you go in and start fixing
things.

Our favorite repair tool in DM is the Merge tool.  It takes edges
or surfaces that are connected without any sharp corners and
merges them into new smooth entities.  Figure 3 shows a
typical example for edges and Figure 4 shows the same for
surfaces.  You can do an automatic merge or pick entities that
you want merged.  The automatic is a great way to get rid of
small slivers without having to hunt them down.  This tool is
also useful for simplifying your geometry in order to get a
better mesh.  Figure 5 shows how you can really clean up a
fillet and the suction side of a turbine blade.

Sometimes you just want to de-feature your model by deleting holes, fillets, bosses, etc…  You can do most of that with the Edge and
Face Delete commands.  They can be found under Tools and they work as you would expect. You simply identify the

Banishing the Bad
Geometry Blues with

Design Modeler

(Cont. on pg. 9)

Figure 2: Small Entities

Figure 1: Import Options

Figure 3: Merge Edges

(Cont. on pg. 9)
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face or edge you want removed and the
program takes it out and heals the solid.
Figures 6 through 8 show examples.  We
find that this is the most efficient and
controlled way to disfeature a model and
get rid of tiny geometry that is causing
issues.

If, after using the tools mentioned above,
you still have the bad geometry blues
you can get down and dirty with a set of
repair tools that address the most com-
mon  issues.  They can all be found under
Tools-> Repair.  The names are pretty self-explanatory.  There are tools for removing slivers, spikes, small edges, small faces, seams,
holes, and sharp angled surfaces.  Most of them work the same way – you can specify a size and any features under that size get cleaned,
or you can pick on geometry. The remaining figures show examples of the various options.

One small side note before we finish, most of the options available in the menu can be displayed as icons in the tool bars if you go to
Tools->Options->Toolbars. If you are doing a lot of repairs, we recommend that you add the tools you are using to the toolbars.  Another
important thing that users should know is that you can repair geometry and save it as an ANSYS ANF file, the native file format for
ANSYS Mechanical APDL. So even if you are not meshing or pre-processing in Workbench, you can still use this tool to clean up your
geometry.

After spending years repairing bad geometry we are thrilled to have these tools in our main software product. Removing the need to
jump out to other programs.  Take the time to learn these tools, when they
work and when they do not, and understanding their options has paid off in
chasing away our bad geometry blues.

(Bad Geometry, Cont...)

Figure 4: Merge Faces Figure 5: Merge Faces Cleanup

Figure 6: Delete Faces to Remove
Fillets

Figure 7: Remove Edges
Figure 8: Remove Faces to

Remove Features
Figure 9: Repair Tools
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In the past we have finished up The Focus with a page we called “Shameless Advertising...”
The truth was that the page was really only advertising PADT, and PADT related things.  So,
instead of doing advertising we thought we would just dedicate the final page to explaining
who PADT is, what we do and how we can hopefully help you.  And, to make sure you read
it, we will try and stick something funny in.  Want to know more?  Call Stephen Hendry at
207-333-8780 or e-mail steve.hendry@padtinc.com.

Humor: Why the Chicken Crossed the Road... In the Words of the Star Wars Characters
(www.maniacworld.com/star_wars_jokes/Star_Wars_Jokes.html)

Rapid Prototyping
Did you know that PADT, Inc. is one of the most respected Rapid Prototyping service
bureaus in the world?  For 16 years, since the founding of the company, PADT’s RP
group has been providing high quality prototype parts to customers around the world.

In that time the RP market has changed, and most small service bureaus have long since been gobbled up by larger firms or just plain
gone out of business.  But PADT has held our own by providing a high level of technical expertise and customer focus - similar to
what has made the company a leader in the ANSYS world.
On site we have machines that use the three leading technologies: Photolithography, Fused Deposition Modeling, and Selective Laser
Sintering.  We also have a CNC mill and lathe, hand finishing tools, and a full paint booth so we can create that perfect part that
customers expect.  The same team also provides soft tooling (rubber molding) and injection molding for when you need to move
beyond prototypes.  Next time you need a prototype, please consider having PADT provide a quote.
Visit the rapid manufacturing part of our web site (www.padtinc.com/rm) or e-mail rp@padtinc.com to learn more.

PADT on the Web
www.PADTINC.com  PADT’s main website

www.PADTMedical.com Medical device development
www.DimensionSCA.com A machine that PADT makes

www.PADTMarket.com A place to buy 3D Printers & Supplies
www.XANSYS.org ANSYS User forum

Need ANSYS Help?
PADT can help in many different ways, here are a few:

� We hold training here or at your facility <link>

� Leverage our APDL knowledge with the APDL Guide <link>

� Consider one-on-one support through mentoring, a great
way to get a quick start on something new <link>

� Attend a PADT Webinar <link>
Join us on Facebook!

Search for  PADT, Inc. and become a fan!

VADER: Because it could not resist the power of the Dark Side.
YODA: Crossing the road makes not a chicken great.
LUKE: I want to follow the ways of the chicken and cross the road like my
father.
LEIA: I don't know... but I have a bad feeling about this.
HAN: Hurry up, colonel sanders, or you're gonna be a permanent resi-
dent!
THREEPIO: I am fluent in over six million ways of crossing the road.
BEN: Cross the road, chicken. Let go, chicken. Chicken - trust me.

BIGGS: At that speed, will you be able to cross in time?
TARKIN: The regional governors now have direct control over their
chickens. Fear will keep those chickens in line... fear of getting hit by a
car!
ADMIRAL ACKBAR: All chickens - prepare to cross the road on my mark
LANDO: Why you slimy, no good, double-crossing chicken!! You got a lot
of guts crossing that road, after what you pulled!
EMPEROR: Young fool. Only now, after getting hit by a car do you
understand.
JABBA: Bo shuda chicken!

mailto:steve.hendry@padtinc.com
http://www.maniacworld.com/star_wars_jokes/Star_Wars_Jokes.html
http://www.padtinc.com/rm
mailto:rp@padtinc.com
http://www.padtinc.com
http://www.padtmedical.com
http://www.dimensionsca.com
http://www.padtmarket.com
http://www.xansys.org
http://www.padtinc.com/support/training/
http://www.padtinc.com/support/techguides/
http://www.padtinc.com/support/mentor/
http://www.padtinc.com/epubs/seminars/default.asp
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